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ACORNS User Manual 

[A][C]quisition [O]f [R]estored [N]ative [S]peech 
 

 

 

The purpose of the ACORNS software package is to support language revitalization efforts of Native 

American tribes. Its name, [AC]quisition [O]f [R]estored [N]ative [S]peech, reflects this purpose. Also, 

as the Acorn is sacred to the tribes of Northern California and Southern Oregon, the name ACORNS is 

chosen in honor of the tribes who helped spawn this effort.  

 

ACORNS software runs on all major desktop computer platforms. Lessons created by ACORNS will 

successfully execute on mobile devices using popular Browser applications. Weôve also created an 

Android and Apple Acorns Gallery mobile application that maintain and execute a gallery of ACORNS 

lessons. We eagerly seek your comments and feedback. 

 

ACORNS is freeware and can be used for any non-commercial legal purpose and can be installed on as 

many computers as you wish. We hope that the software proves useful but provide no guarantees to its 

suitability. The author of the original program, Dan Harvey from Southern Oregon University, retains 

full copyright privileges. Because of its purpose to support tribal revitalization, we do not want the 

software sold for profit. Use of the software implies agreement with these terms. Please feel free to 

contact the author (harveyd@sou.edu) if you have any questions or comments regarding permissible 

use.  

 

In the future, we plan to release the source codes. Distribution will then be subject to Open-Source 

GNU licensing whose licensing terms are described at HTTP://www.gnu.org/copyleft/gpl.html.  

 

mailto:harveyd@sou.edu
http://www.gnu.org/copyleft/gpl.html
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Chapter 1  General Operation  

 

 

Clicking the ACORNS icon brings up a frame like the one in Figure 1-1. Notice that many of the icons 

on the tool bar are ghosted (faded); this means they are not yet enabled. You can enable most of them 

simply by opening or creating an ACORNS file.  

 

The ACORNS program operates in ways similar to many popular presentation programs, like Power 

Point for instance. However, instead of composing slides to be displayed in a Power Point slide show, 

we create a file of language lessons to be used interactively when a student executes them. It is our 

hope that this popular interface concept will be intuitive and easy to learn. 

Figure 1-1 ACORNS application frame 
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Section 1.1 ACORNS icons and menu options 

Figure 1-2 offers a closer view of the icons we saw at the top of the ACORNS frame in Figure 1-1. 

Clicking these icons will trigger one of the more common operations that ACORNS performs. (Less 

common operations are not found on the tool bar; they can be accessed in other ways.) If you rest your 

mouse over any of the icons shown, a short description of its operation will appear. 

 

 

 

 

 

 

There is an alternate method for executing ACORNS options. At the top of the frame is a series of 

menu selections. Figure 1-3 shows what happens if you click the File selection: a list of clickable 

options drops down. 

 

Note that the most commonly used options in Figure 1-3 have an icon next to them. Less common 

options do not; for example, look at the Properties option. If all the menu options had icons, the 

ACORNS frame would grow quite cluttered. 

 

In Figure 1-3, the menu also indicates hot-key, or shortcut, options. For example, Ctrl-N means that the 

user can trigger the New option by typing command (control ï n). In other words, hold down the 

control key, tap the N key; then release the control key. (Note: On MAC systems, the shortcut is 

command ï n.) 

Figure 1-2 ACORNS icon toolbar 

Figure 1-3 ACORNS dropdown menu 
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Some of the ACORNS options have multiple levels of menus, as shown in Figure 1-4. In this case, we 

click the Edit menu, then the move the mouse to the Modify option (edit - modify). This triggers a 

second-level menu with further options: Lesson and Fonts. Any option that has a second-level menu 

will have a small arrow to its right. Thus, in the example below we can see that the Insert and Delete 

options also have second-level menus. 

 

Note that the Undo, Redo, Copy Lesson, Paste Lesson, and Lesson options are ghosted. They require an 

active lesson to enable. 

Figure 1-4 multi-level menu 
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Chapter 2  Work  with  ACORNS Files 

 

An ACORNS file is a collection containing one or more language lessons. This chapter describes how 

to manage a file of language lessons. For example, we might want to create a new file; open a file 

previously created; close a file after use; or modify the properties associated with a file. This chapter 

describes these and other operations in the sections that follow. 

Section 2.1 Create ACORNS files 

The easiest way to create a new file is to click the leftmost icon at the top of the ACORNS frame (recall 

Figure 1-2). It looks like a blank sheet of paper with the top-right edge folder over. When you click this 

icon, your display will show as Figure 2- 1. 

 

 

Figure 2- 1 ACORNS after creating a file 

 

Notice that the frame has two display areas. The left side will display a list of language lessons. The 

right side will show the current lesson. To this point, we've only created the file, so no lessons are 
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shown as yet. Now find the two gray arrows just below the icon bar, between the display areas. If you 

should ever want to hide the Lesson List and expand the Lesson Display, click the arrow pointing to the 

left. You can later restore the Lesson List by clicking the arrow pointing to the right.  

Section 2.2 Open an  ACORNS file 

Opening a file means getting it back so you can work on it some more. As with other options, there are 

several ways to do this. On the tool bar, simply click the Open icon, second from the left (recall Figure 

1-2). This icon shows an opening yellow folder. Alternatively, Figure 2- 2 provides a display showing 

how you can open a file through the drop-down menu (file ï open), where you will see the same icon. 

You can also use the hot-key (control ï o or command ï o) to open an existing file. 

 

 

Figure 2- 2 File dropdown menu 

 

No matter which of these methods you choose, the Open option triggers a dialog where you can browse 

for your file. In Figure 2- 3, for example, we see the Mac version. Notice that the button at the bottom 

says Open. Using this dialog, if you see your file listed, you can click on it and then click the open 

button. Otherwise, you click the dropdown arrow to show a list of folders that you can navigate through 

your system folders to find your ACORNS files, which have .lnx (L-N-X) extensions. This navigation 

technique is common to most applications on your system, so we wonôt discuss it further here. 

 

There are actually several additional ways to open a file.  (1) If you've worked with a file recently, it 

will be listed on the bottom of the File drop-down menu with other recently opened files (see the 

bottom of Figure 2- 2) and the most recently opened file appears at the top of the list. Simply click the 

one you want to open. (2) On Windows or Mac systems, you can find your ACORNS files by 

navigating through your file system folders to the one containing your ACORNS files. If you are 

looking at the contents of a folder in your directory and you want to open one of the files listed, simply 

double-click the one you want. This will launch the ACORNS program and open the file in one step. 
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(3) If the ACORNS application is already running, you can drag the file from its folder and drop it on 

the ACORNS program application window. (4) Finally, on MAC systems, you can drag the file over 

the ACORNS application icon to launch the application with the file automatically open. 

 

 

 

Section 2.3 Save your work  

When you are finished working with an ACORNS file, and periodically while you're working, you'll 

want to save your work. Click either the Save or Save As icons on the tool bar. The Save icon is a 

picture of a cassette (or, as some will recognize, a diskette). The Save As icon has a picture of two 

diskettes. Of course, you can also trigger these options using the drop-down menu options: (file ï save) 

or (file ï save as). Alternatively, the Save option has a shortcut key (control ï s or command ï s). It is a 

good idea to save your work frequently. You wouldn't want to lose everything should there be an 

interruption in power. 

 

The difference between Save and Save As is this: Save As gives you a chance to select a new file name 

and/or file folder (allowing you to locate your file in a different place in your computer). The Save 

option uses the name and folder previously assigned. Of course, if you've not yet assigned it a name 

because this is the first time you've saved, you will be asked to name your file. In other words, when 

you save for the first time, there is no difference between Save and Save As. 

 

If you don't type a name for your file when saving for the first time, ACORNS automatically assigns it; 

it picks the title of the first lesson in the file. If there are no lessons yet added it will use  acorns. In the 

Figure 2- 3Open file dialog 
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latter case, it's a good idea to change the default. Otherwise, it can mistakenly be replaced when 

creating another lesson. When naming files, a rule of thumb is to use lower-case letters, keep the names 

short, and avoid using spaces. These conventions will ensure that your file names function no matter 

which computer platform you might use in the future. Another good suggestion is to save your 

ACORNS files consistently in the same folder. This will save you confusion trying to locate your files 

when you want to work with them again. 

 

Figure 2- 4 shows the dialog you'll see if you are saving your work on a MAC. It might look different 

on other platforms, like Windows XP. This is because it will follow your platform's standard. Note that 

the dialog is very similar to that of Figure 2- 3 for opening files. The difference is that the button on the 

bottom says save instead of open. 

 

Section 2.4 Export a file  

Export your files when you want to format them for archival purposes. The Save option is not sufficient 

for this, because when you save, ACORNS stores your file in an internal format which external 

programs cannot understand. However, the Export option preserves multimedia, audio, and video in 

standard formats, and saves lesson data in a universally understood text-based XML file. When you 

Export, ACORNS creates an XML file (filename.xml) where filename is the name of your file. The 

ACORNS program also creates a folder with the same name (but without an .xml extension) that 

contains all of your audio and pictures. Other multimedia applications understand how to access these 

files.  

 

Export makes it is easy to program external applications to work with your lessons. In this way, we 

solve one of the historic problems with linguistics data: in past years, linguistics programs utilized 

proprietary formats that were lost as soon as the program that generated the data was no longer 

supported. 

 

Figure 2- 4 File save dialog 
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The Export icon on the ACORNS toolbar looks like an open book with a red arrow pointing out of the 

book. You can either click the Export tool bar icon, or click (file ï export) from the drop-down menu. 

The Export dialog, shown in Figure 2- 5 (this time we show the dialog as it displays on Windows 

systems), works much like Save and Save As. It gives you an opportunity to name your file and choose 

a folder in which to store it.  

 

You also have a chance to change your file's audio and video format to all the choices available on your 

systemï but be careful choosing from the options provided. While the defaults are compatible with all 

major computer platforms, some of the formats offered are not. For example, spx is an audio format 

designed specifically for speech. It compresses speech better than the other formats, so it is good for 

web-page applications, greatly reducing download time. However, it has two disadvantages. First, not 

all media players can use this format. Second, though playback is quite efficient, it takes longer to 

encode files in this format. 

 

Figure 2- 5 Export file dialog 

Section 2.5 Import  a file after export  

The Open procedure will not work for files that you've exported. To get these back, you need to use the 

Import option. The Import icon looks like an open book with a red arrow pointing into the book. You 

can either click the Import tool bar icon, or click (file ï import) from the drop-down menu. A dialog 

will appear, letting you browse for your exported file. This dialog looks much like the one used for 

opening files, except that now you will be choosing files with the XML extension at the end of their 

name. After importing a file, you can save it using the Save option, or export it again. Remember: you 

use the Open option to work on files that were saved and the Import option to work on files that were 

exported. 
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Section 2.6 Close a file when you are finished 

If you are finished working with a file, use the Close command. The Close icon appears as a red X. You 

can also select Close from the drop-down File menu. Should you forget to save before closing; 

ACORNS will remind you with an alert message, as shown in Figure 2- 6. If you don't want to keep the 

changes made since your last save, click the No button. Clicking Yes will save your work under the 

name you've previously assigned to the file. If you click Yes for a file that doesn't yet have a name, 

ACORNS will assign it the default name acorns## (or it will choose the title of the first lesson in the 

file). Instead of clicking Yes in this case, it's a good idea to click Cancel; then use the Save As option. 

Once the file is saved, you can again try the close option. 

Section 2.7 ACORNS file properties 

One of the options you can select from the File menu is Properties. When you select this option, a 

dialog appears as shown in Figure 2- 7. Here you can indicate the language to which your file applies, 

the author who created the file, and a description of the lessons in the file. At present, these data are 

optional and for informational purposes only. You can ignore this entry if you wish. 

 

Figure 2- 6 Close file dialog 

Figure 2- 7 File properties 
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Section 2.8 Delete ACORNS files 

Occasionally, you might want to remove an ACORNS file from your computer. You can do this by 

finding the files in the Operating System folders. Alternatively, you can use the ACORNS menu option 

and click (edit ï delete ï file). A file-chooser dialog will come up, allowing you to select the files you 

want to delete. In fact, you can select any file, not just ACORNS files ï so be careful when you use this 

option. 

 

Section 2.9 Create a web page or a mobile application  

The ACORNS application can create web pages out of the lessons in your files. Even if you never 

upload your work to Web servers, you can save to a CD or thumb-drive and distribute it to students (or 

anyone interested), allowing them to use your lessons without requiring them to install ACORNS 

software. When they open your file, their browser window wil l launch your lessons, just as if your 

lessons were a web site. Of course, you can also post your web pages online, allowing anyone with 

Internet access to view them. In either case, this is an excellent way to publish your work. Note that this 

is the way for you to let students to execute your lessons without being able to make alterations. 

 

The ACORNS application provides two icons for creating web pages. The first uses the Make Web 

Page icon ( ); the second uses the Make Mobile Application icon ( ). Note that the Make Web Page 

icon on your tool bar looks like a spider web, and the Make Mobile Application icon looks like a 

mobile phone. You can also invoke either of these options from the ACORNS File menu.  

 

The Make Web Page option was the standard way to generate web pages in previous versions of 

ACORNS. It created a Java Applet which runs on desktop browsers. Unfortunately, because of security 

risks, todayôs popular mobile devices no longer support Java, so this option is no longer useful. For this 

reason, executing this option automatically transfers to the Make Mobile Application program.  

 

The Make Mobile Application option generates web pages that successfully execute on browsers 

installed on todayôs popular mobile devices. ACORNS mobile web pages automatically configure 

themselves to varying display sizes and recognize when the devices are in portrait (vertical) or 

landscape (horizontal) mode. Note however, that there are some differences in how browsers display 

web-pages and interact with the user. For example, some browsers require two finger gestures to scroll 

portions of web-pages, whereas most support single finger touch scrolling. We advise, therefore, that 

you download/install browsers that work best for your tribal applications.  

 

Figure 2- 8 shows the dialog for creating a mobile application. This dialog allows you to override the 

title of the web-page. There is also a check box indicating whether audio recording is enabled. This 

option applies to desktop browsers, and allows students to record and playback their recorded voice to 
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compare their speech to those of expert speakers. If you execute ACORNS lessons within the Android 

gallery application, audio recording is always enabled. 

 

We do not recommend using this option, because, for security reasons, it requires explicit permission 

granted by users or desktop browsers will block its execution. There are draft W3C proposals that 

under consideration, so this restriction is likely to be relaxed in the future when these proposals become 

industry-standard and become widely supported. For now, it is a good idea to go with the default, 

which is to keep the audio recording option disabled.  

 

 

Figure 2- 8 Mobile web-page creation dialog 

 

The ACORNS mobile web-page option creates a file for each file of lessons (allLesson.html in the 

above example) and also a folder (same name, but without the extension) with all of the associated 

audio and picture components. If you plan to distribute your lessons on a CD, or post them on the Web, 

the file with the .html extension and its associated folder go together. Browsers need both the web page 

and the folder in the same directory to successfully be able to execute the lesson. 

 

The mobile web-page option also creates another file with an .acorns extension. Weôve developed 

gallery applications for both Android and Apple mobile devices that use the .acorns file. After 

installing the mobile application, you can distribute the .acorns file by e-mail, store it using a cloud-

based service like Drop Box, or store it in a known location on the Web. E-mail, Drop Box, and 

Browser applications each have share options which will automatically launch the ACORNS Gallery 
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application. For example, using Drop Box, simply touch the .acorns file, and the ACORNS Gallery 

application automatically launches to display the lesson. Email and Browser applications have share 

settings that do the same thing. We provide more information about the Gallery applications in separate 

documents. 

 

If you donôt care to install the ACORNS Gallery applications, you can still execute these lessons on 

mobile devices. With a USB cable, Android allows you to copy files back and forth to the device, but 

this process is somewhat complicated, requiring some knowledge of the Android file system, and 

therefore is beyond the scope of this document. Apple mobile devices are more difficult in that these 

donôt allow you to easily copy files back and forth. Of course, you can always post your web pages to a 

tribal server and execute them from within most Browser programs. 

 

A summary of the steps we just explained follow: 

 

1. On your desktop or laptop computer, create your lessons using the ACORNS application. 

2. Click the Make Mobile Application icon to create your mobile web page. By default, ACORNS 

will create two key files (<lessonName>.html, and <lessonName.acorns>) and a folder 

(<lessonName>) in the Documents Acorns folder (or acornsFiles on previous installations) on 

your computer. On Apple Store obtained versions, ACORNS will employ a user-selected folder 

instead of those indicated above. Clicking/touching on the <lessonName>.html file launches the 

lesson to execute in a Browser application. 

3. Install the ACORNS Gallery application on your Android or Apple phone or tablet. 

4. Distribute the file with the .acorns extension using e-mail or a cloud-based service like drop 

Box to your mobile device. 

5. Use the share facility of e-mail or Drop Box to display your ACORNS lessons within the 

Acorns Gallery application.  

6. Within the Android Acorns Gallery application, touch the save button to store it permanently in 

the gallery of ACORNS lessons. The Apple version does this automatically. 

 

There is one final consideration, which is important if your tribe uses custom indigenous fonts. Many 

mobile devices do not allow you to install custom fonts. Furthermore, embedding fonts directly in a 

web-page is desirable because users donôt have to install the fonts locally, even if this were possible. 

On your desktop (or laptop) computer, ACORNS creates an Acorns directory (within your user 

directory), with a sub-folder called Fonts. With previous ACORNS versions, you needed to copy your 

indigenous .TTF font files to this directory. This is not required in the current version. Whenever 

ACORNS creates web-pages, the fonts used are automatically embedded into the web-pages that it 

creates. 

Section 2.10 Windows for mul tiple open files  
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Sometimes it is convenient to work on multiple ACORNS files at once. Figure 2- 9 shows how the 

Windows menu options appear when three files are open at the same time. The check mark indicates 

the active file, which will appear in the Lesson Display area. You can switch the active file by clicking 

any of the other files listed. 

 

You can display multiple open files in several ways. Full Screen view is the default. It displays your 

fi les one at a time with no tabs. To switch between files in Full Screen, you need to go to the drop-

down Window menu, shown in Figure 2- 9 and click Full Screen. 

Figure 2- 9 Windows commands 

Figure 2- 10 Tabbed view of open files 
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Tabbed View  (Figure 2- 10) works much like the tabs in a web browser, placing each new file on its 

own tab within the same window. You activate this view by clicking on Tabbed View in the  
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drop-down menu. The ACORNS program shows your tabs in the display area, allowing you to navigate 

quickly and easily between them. Just click the tab with the name of the file you want. The figure 

above illustrates the tabbed view, where the active lesson is about shapes. Notice the white tab bar at 

the top of the Lesson Display area; the selected file name is highlighted in blue. Meanwhile, Figure 2- 

11 presents the full screen view, where the active file is a lesson about horses. 

 

Section 2.11 Prin t and print preview  

Often you might want a hardcopy printout of the information contained in a lesson. The Print and Print 

Preview commands are provided for this purpose. Print Preview, shown in Figure 2- 12 allows you to 

view the information before it prints. Note that you can alter the zoom by selecting a percentage value. 

Higher values will display the information in more detail, but you'll have to scroll to view it all. With 

lower values, you can view your page as small as a thumbnail. The default, shown below, is a 10% size. 

To print, simply click the Print button and then select the printer you want and optionally, a range of 

pages to print. If you want to exit without printing, click the Close button.  

 

The icons for Print and Print Preview should be familiar, as they are standard for most applications. 

The Print icon is marked by the image of a printer. The Print Preview icon shows a page beneath a 

magnifying glass. These commands can also be found under the File menu. Additionally, Print has a 

shortcut key (control ï p or command ï p). 

 

Figure 2- 11 Full view of open files 
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Figure 2- 12 Print Preview 
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Chapter 3  Work  with Language Lessons 

 

Once you create a file, the next step is to create a language lesson. There are two modes of operation 

when working with language lessons. The first is Setup Mode where you go through the steps needed 

to prepare a lesson for execution. The second step is executing that lesson. For those comfortable with 

the Microsoft Power Point application, the interface is similar. The difference is that instead of creating 

a file of slides for a presentation, we create lessons for learning language. Instead of presenting a slide 

show, we execute language lessons that interact with a student. 

Section 3.1 Create a language lesson 

To create a language lesson, click the tool bar icon with the light bulb. (You can remember this by the 

phrase, ñThe light bulb went on!ò meaning you got a bright idea about what kind of lesson you want to 

create.) As described above, you can also trigger this option by going through the Edit menu (edit ï 

insert ï lesson) or using the hot-key (control ï l or command ï l). In any case, the dialog box shown in 

Figure 3-1 will appear, and you will be able to enter your Lesson Header data. 

 

 

Figure 3-1 Create lesson dialog 

You are required to make at least two inputs at this point. First, click the drop-down arrows beside the 
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Please Make a Selection field; then select a lesson type. We'll describe the differences between lesson 

types in subsequent chapters. ACORNS supports a variety of lesson types; and we expect that this list 

will expand as we continue to enhance the ACORNS application. 

 

The second required entry is the lesson title. You can choose any title you like to identify your lesson.  

 

You're not required to make an entry in the Lesson Name field, but this is an important option. Later 

you will learn how to build links between lessons in your file; to do this you will need a lesson name. 

It's a good idea to choose a short, one- or two-word name, which you find easy to remember.  

 

The Lesson Description is for informational purposes only. In the future, we may implement search 

engine features to locate lessons according to what this field contains. The Lesson Description allows 

you to state the lesson's purpose in your own words, free-form. You may leave this field blank for now 

if you wish. 

 

Every lesson type can have up to ten layers and you can identify each of these layers with a descriptive 

name. Students will see these names when the lesson executes. Lesson layers can be used to reflect 

particular language dialects or perhaps, levels of difficulty. You are free to use the different layers for 

whatever purpose you desire. In Section 6.4, we describe how you can standardize layer names, so you 

donôt have to type these descriptions each time you create a new lesson. If you donôt plan to utilize the 

layer feature, you can leave the layer name fields blank. 

 

When you're done, click Yes. Your Lesson Header will display in the Lesson List area, as shown below 

in Figure 3-2 which shows the header for a Picture and Sound lesson. 

 

Figure 3-2 A created Picture and Sound lesson header 

Section 3.2 Edit lesson header information  

Even after entering your Lesson Header, you can easily change its data if you like. There are two ways 

to do this. The first is through the Edit menu (edit ï modify ï lesson). You'll note that the Lesson option 
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will be active now, not ghosted as it was before (recall Figure 1-2). The second method is to click the 

Lesson List button in the list area, calling up the menu shown in Figure 3-3. Click Modify Lesson to 

display the dialog we saw in Figure 3-1. You can change anything you like except for the lesson type. 

That field cannot be changed. 

 

Alternatively, you can change lesson or layer names by directly typing into the text fields of the Lesson 

List (shown in Figure 3-2). 

 

Section 3.3 Navigate between lessons 

A single ACORNS file can contain many language lessons. It is important to have an easy way to 

switch from one to another. One way to switch between lessons is simply to click the desired lesson 

from the Lesson List. (You might have to scroll if there are more lessons than can fit in the Lesson List 

display area.) A second method is to use the navigation buttons shown at the bottom of the Lesson List 

area (Figure 3-4). Note that the <<, <, >, and >> buttons respectively switch to the first, previous, next, 

and last lessons in the ACORNS file, respectively. 

 

 

A third way to navigate between lessons is to use the keyboard Home, Page Down, Page Up and End 

keys on your keyboard. These keys work just like the navigation buttons we just described. 

Figure 3-3 Change the lesson header 

Figure 3-4 Lesson navigation buttons 
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Section 3.4 Alter  lesson order 

If you create a file with lots of lessons, you might want to change their order. For example, in Figure 

3-5, you might want Lesson 2 to become Lesson 1, and vice versa. Simply move your mouse over 

Lesson 2 in the Lesson List, press and drag. A horizontal line will appear marked by an acorn in its 

middle. Lesson 2 will be inserted where this line rests when you let up on the mouse. 

Section 3.5 Copy and paste lessons 

Sometimes, you might want to use the same lesson in more than one ACORNS file. The Copy and 

Paste options make this task easy, so you do not have to recreate the lesson from scratch. To copy the 

currently active lesson (the one showing in the ACORNS lesson display area), you can click on the edit 

drop-down menu, and then choose copy lesson. You can instead, if you wish, use the shortcut key 

control ï c (or command ï c), which is standard across many applications. When you execute this 

option, ACORNS copies your lesson to a system wide clipboard. You then are safe to switch to another 

file using the Window drop-down menu commands. You can also paste into the same file if you wish. 

Position to where you want the lesson to go, and then execute the paste lesson option. The paste option 

is also on the edit drop-down menu. Alternatively, you can use the shortcut key, control ï v (or 

command ï v), again standard across many applications. Your lesson now will be part of the new file. 

Note that this copy paste operation is possible when you have more than one instance of the ACORNS 

Figure 3-5 An ACORNS file with two lessons 
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application running. You can copy a lesson from one instance and paste it to another. 

For some lesson types, you can use the paste option to change the lesson type. For example, you can 

copy a Multiple-Choice lesson and then paste it as a Flash Card lesson. This is convenient because you 

wonôt have to recreate the whole lesson. When it is possible to change the lesson type, the paste option 

will display a drop-down menu, similar to the one shown in Figure 3-6. Simply, click on the arrow 

pointing down and then select the lesson type that you want. 

 

Figure 3-6 Paste Lesson type sélection 

Section 3.6 Delete a lesson 

Occasionally, you might want to remove a lesson from your file. This is easy to do. Just click (edit ï 

delete ï lesson). Another way is to click the Lesson List button (shown at the top of Figure 3-5) and 

select the Remove Lesson option.  
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Chapter 4  Recover  Lost Data 

 

Occasionally, we might make a mistake and inadvertently make changes to a file or to a lesson that are 

incorrect. There are several facilities built into the ACORNS program to help recover from these kinds 

of problems. This chapter describes these procedures. 

 

Section 4.1 Undo and redo 

The Undo and Redo commands have icons on the ACORNS main toolbar. The Undo command has an 

icon with a picture of an arrow pointing to the left. Redo has an icon containing an arrow pointing to 

the right. These commands can be found on the tool bar, as well as under the Edit menu. The standard 

shortcut keys for these commands are (control ï z or command ï z) for Undo and (control ï y or 

command ï y) for Redo. 

 

Undo is useful when you decide that a change you've made was a mistake. Clicking Undo will restore 

the lesson to the way it was before you made the change. The Redo command is useful when, after 

clicking Undo, you realize that the change you made wasn't a mistake after all. Clicking Redo will 

restore the change. Note that Figure 4-1 shows Undo as ghosted, signifying that there are no changes to 

undo. If we click Redo, the Undo button will activate and the Redo button will be ghosted. 

 

Section 4.2 Recover data from b ackup files 

When you save a file, the changes can no longer be recovered using the Undo and Redo options. 

However, there is still a way to proceed. 

 

When you save your work, the file is saved with a .lnx extension. (The extension should be typed in 

lower case, but note the spelling, L-N-X.) Each time you perform subsequent saves, ACORNS 

automatically creates a copy of your file as it was before you made any changes. Thus, if you make a 

mistake in saving, all is not lost: you can restore the previous version. The earlier version, however, 

will be saved with a .bak extension. The version older than that will be renamed with a .bk2 extension. 

If you need to recover the previously saved files, simply rename the .bak file (or .bk2 file), making sure 

to use an .lnx extension. The process of renaming varies from platform to platform. In Windows for 

example, view the folder where your file is stored, right-click on the file, and select Rename. 

Hopefully, if you are careful, you won't have to use this "last resort" feature very often, or at all. 

Figure 4-1 Undo and redo icons 
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Chapter 5  Help Facilities  

 

The ACORNS program includes several resources to help you learn the program. This chapter 

describes these resources. If these approaches fail, there is a discussion forum at the ACORNS web-

site. At that site, you can post questions or suggestions. 

Section 5.1 Feedback messages 

The most straight forward way to receive help is the bottom line of the ACORNS application frame. 

This area presents confirmation or error messages that indicate whether a command executes 

successfully or not. Recall that in our discussion about creating a web page, we learned that an error 

message will appear here if you choose an inappropriate width or height for the web page that you are 

creating. Figure 5-1 shows an example of the feedback message displayed after a new lesson is created. 

It appears at the bottom of the ACORNS application window. 

 

Figure 5-1 Feedback message 

Section 5.2 Tooltips  

Another help aid appears when you move your mouse over a text field or button. Most of the time, 

ACORNS will provide a short description of the field or button in question. This facility is helpful if 

you forget what a particular icon is for. 

Section 5.3 Context-based help 

There are specific help buttons that you can click to obtain a textual description of a particular option. 

Recall Figure 3-3, for instance. Notice the Help option in the drop-down menu. Clicking this option 

gives you a page of instructions regarding how the Lesson List works. Other context-based helps exist 

throughout the ACORNS application, and we'll come to these in the chapters where they apply. 
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Section 5.4 Full featured help facility  

A fully equipped help facility executes when you click the tool bar's Help icon, which pictures a yellow 

question mark. You can also reach this feature by going through the drop-down Help menu. The 

shortcut key for the help facility is function key one (F1). (If you use a Mac, make sure to click F1 with 

the fn key depressed.) When you execute the Help command, a dialog like the one in Figure 5-2 will 

display. It works much like a web browser. Note the four buttons at the top: the two on the left work 

like Forward and Back buttons of a web browser, allowing you to navigate to previously viewed pages. 

The Home button returns you to the overview page. The Print button triggers a hard-copy printout of 

the page on display.  

Subsection 5.4.1 Table of contents 

This help facility has three modes of operation. This section describes the first mode, called Table of 

Contents. Here you will see interactive options based on what you would find at the front of a book. 

 

Whenever you see a right-facing arrow next to a line, it signifies that this is a category containing sub-

options. To view them, simply click the line. The sub-options will drop-down, and the "right" arrow 

will change to a "down" arrow. If you would like to compress the sub-options again, simplifying your 

table, just click the "down" arrow and watch them disappear. You can make them appear and disappear 

as many times as you like. If a line does not contain sub-options, instead of an arrow, it will show the 

image of a notebook page.  Click this line, and information will appear in the display to the right. 

 

For an illustration, note Figure 5-2. The line entitled Introduction is open, as you can see by the "down" 

arrow to its left. It contains one sub-option, Overview, marked by a page instead of an arrow. Other 

Figure 5-2 Help command 




































































































































